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I. PHẦN TRẮC NGHIỆM (3,0 điểm) 
Câu 1.1: Lợi ích chính của việc quản trị CSDL trên máy tính là gì? 
A. Tăng tốc độ xử lý dữ liệu và hạn chế sai sót.
B. Giảm yêu cầu về phần cứng.
C. Không cần nhân lực quản lý.
D. Tăng chi phí quản lý.
Câu 1.2: Trong hệ quản trị CSDL, chức năng nào giúp đảm bảo tính nhất quán của dữ liệu?
A. Tính toàn vẹn dữ liệu.
B. Tính phân quyền người dung.
C. Tính khả dụng cao.
D. Tính bảo mật dữ liệu.
Câu 1.3: Tại sao MySQL được ưa chuộng trong quản trị CSDL? A. Vì có giá thành thấp.
B. Vì nó là phần mềm mã nguồn mở và miễn phí.
C. Vì chỉ hỗ trợ cho các hệ thống nhỏ.
D. Vì không cần phần cứng mạnh.
Câu 1.4: Chức năng nào của hệ quản trị CSDL giúp bảo vệ dữ liệu khỏi những truy cập trái phép?
A. Tính toàn vẹn dữ liệu.
B. Tính phân quyền người dung.
C. Tính nhất quán dữ liệu.
D. Tính lưu trữ.
Câu 2.1: Phần mềm HeidiSQL được sử dụng để làm gì trong quản trị CSDL? A. Quản lý giao diện đồ họa cho MySQL.
B. Chạy các ứng dụng ngoài hệ thống.
C. Tăng tốc độ xử lý MySQL.
D. Quản lý bộ nhớ máy tính.
Câu 2.2: Một trong những lợi ích của việc sử dụng hệ quản trị CSDL là gì? A. Dữ liệu được lưu trữ trực tiếp trên giấy.
B. Dữ liệu có thể được truy xuất và chỉnh sửa nhanh chóng.
C. Hạn chế quyền truy cập của tất cả người dung.
D. Không cần kiểm tra dữ liệu.
Câu 2.3: Hệ quản trị CSDL MySQL chủ yếu được sử dụng trong các trường hợp nào? A. Chỉ dành cho hệ thống nhỏ.
B. Các hệ thống CSDL lớn và ứng dụng trên Internet.
C. Các hệ thống không đòi hỏi tính an toàn cao.
D. Hệ thống không có kết nối mạng.
Câu 2.4: Một tính năng đặc biệt của HeidiSQL là gì? A. Chỉ hỗ trợ MySQL.
B. Hỗ trợ nhiều ngôn ngữ, bao gồm tiếng Việt.
C. Không hỗ trợ kết nối Internet.
D. Chỉ có trên hệ điều hành Windows.
Câu 3.1: Lợi ích của hệ quản trị CSDL trong lĩnh vực ngân hàng là gì? A. Giảm thiểu nhân lực.
B. Tăng thời gian xử lý giao dịch.
C. Đảm bảo giao dịch chính xác và nhanh chóng.
D. Hạn chế khả năng tự động hóa.
Câu 3.2: Tại sao cần phải nhập mật khẩu khi truy cập MySQL với quyền root? A. Để bảo vệ dữ liệu khỏi truy cập trái phép.
B. Để giới hạn thời gian truy cập.
C. Để nâng cao tốc độ xử lý.
D. Để kiểm soát quyền truy cập mạng.
Câu 3.3: Trong cấu trúc bảng banthuam(idBanthuam, idBannhac, idCasi), trường nào được chọn làm khóa chính?
A. idBanthuam
B. idBannhac
C. idCasi
D. tenBannhac
Câu 3.4: Tại sao cần tách bảng casi(idCasi, tenCasi) thay vì lưu trữ trực tiếp tenCasi trong bảng banthuam?
A. Giúp giảm dung lượng lưu trữ và tránh trùng lặp dữ liệu.
B. Giúp lưu trữ nhiều ca sĩ hơn.
C. Giúp truy vấn nhanh hơn.
D. Giúp quản lý các bản nhạc phức tạp hơn.
Câu 	4.1: 	Trong 	cấu 	trúc 	bảng bannhac(idBannhac, tenBannhac, 	idNhacsi), trường idNhacsi là gì?
A. Khóa chính
B. Khóa ngoài
C. Khóa cắm trùng lặp
D. Chỉ mục
Câu 4.2: Khi cần quản lý thêm thông tin ngày sinh của các ca sĩ trong CSDL, nên thay đổi như thế nào?
A. Thêm trường ngaysinh vào bảng banthuam.
B. Thêm trường ngaysinh vào bảng casi.
C. Tạo bảng mới lưu trữ thông tin ngày sinh.
D. Không cần thay đổi.
Câu 4.3: Nếu muốn quản lý thêm thông tin nơi sinh của nhạc sĩ, CSDL cần thay đổi như thế nào?
A. Thêm trường noisinh vào bảng nhacsi.
B. Thêm trường noisinh vào bảng bannhac.
C. Tạo bảng mới lưu trữ nơi sinh.
D. Không cần thay đổi.
Câu 4.4: Trường nào trong bảng banthuam(idBanthuam, idBannhac, idCasi) là khóa ngoài?
A. idBanthuam
B. idBannhac và idCasi
C. tenBannhac
D. tenCasi
Câu 5.1: Tại sao cần phải có khóa ngoài trong cơ sở dữ liệu quan hệ? A. Để giảm trùng lặp dữ liệu.
B. Để tạo mối liên hệ giữa các bảng.
C. Để làm cho truy vấn nhanh hơn.
D. Để quản lý được nhiều dữ liệu hơn.
Câu 5.2: Trong bảng nhacsi(idNhacsi, tenNhacsi), idNhacsi có vai trò gì?
A. Khóa ngoài
B. Khóa chính
C. Chỉ mục
D. Trường không cần thiết
Câu 5.3: Lợi ích của việc sử dụng kiểu dữ liệu AUTO_INCREMENT cho các trường khóa chính là gì?
A. Tự động tăng giá trị khi thêm bản ghi mới
B. Đảm bảo giá trị duy nhất cho mỗi bản ghi
C. Giúp truy vấn dữ liệu nhanh hơn
D. Tự động tăng giá trị khi thêm bản ghi mới, đảm bảo giá trị duy nhất cho mỗi bản ghi Câu 5.4: Câu lệnh SQL nào sau đây dùng để sắp xếp dữ liệu theo tên nhạc sĩ theo thứ tự tăng dần?
A. SELECT * FROM nhacsi ORDER BY tenNhacsi DESC
B. SELECT * FROM nhacsi ORDER BY tenNhacsi ASC
C. SELECT * FROM nhacsi ORDER BY idNhacsi
D. SELECT * FROM nhacsi WHERE ORDER BY tenNhacsi ASC
Câu 6.1: Khi tạo lập cơ sở dữ liệu mới trong MySQL, bộ mã ký tự mặc định nào thường được sử dụng? A. ASCII
B. utf8mb3
C. Unicode 2 byte
D. utf8mb4
Câu 6.2: Để tạo bảng "nhacsi" với trường "idNhacsi" và "tenNhacsi", kiểu dữ liệu của "idNhacsi" là gì?
A. VARCHAR
B. INT
C. TEXT
D. FLOAT
Câu 6.3:Trong quá trình tạo bảng, nếu muốn trường "idNhacsi" tự động tăng giá trị, ta phải chọn tùy chọn nào?
A. AUTO_INCREMENT
B. UNSIGNED
C. NOT NULL
D. DEFAULT
Câu 6.4: Để thiết lập trường "idNhacsi" làm khóa chính, ta phải thực hiện thao tác nào?
A. Chọn AUTO_INCREMENT
B. Chọn khóa ngoại
C. Chọn PRIMARY trong phần Create new index
D. Chọn VARCHAR
Câu 7.1: Nếu vô tình chọn sai trường làm khóa chính, cách nào sau đây đúng để sửa lại?
A. Xóa bảng và tạo lại
B. Nhấp chuột phải vào trường sai và chọn Delete column
C. Nhấp đúp chuột vào trường sai và sửa lại khóa chính
D. Đặt trường sai làm khóa ngoại
Câu 7.2: Sau khi hoàn tất việc khai báo bảng, bước cuối cùng để lưu bảng là gì?
A. Đóng cửa sổ tạo bảng
B. Nhấn nút Lưu
C. Chọn Export
D. Chọn Commit
Câu 7.3: Khi khai báo trường "tenNhacsi", kiểu dữ liệu nào phù hợp để lưu tên của nhạc sĩ? A. INT
B. VARCHAR
C. FLOAT D. DATE
Câu 7.4: Khi khai báo trường "tenNhacsi", độ dài tối đa bao nhiêu thường được sử dụng? A. 50
B. 100
C. 255
D. 500
Câu 8.1: Nếu muốn tạo thêm trường mới cho bảng "nhacsi", phím tắt nào sau đây có thể được sử dụng?
A. Ctrl+S
B. Ctrl+C
C. Ctrl+Insert
D. Ctrl+Delete
Câu 8.2: Khi khai báo trường "idNhacsi", để đảm bảo rằng trường này không nhận giá trị
NULL, cần chọn tùy chọn nào?
A. AUTO_INCREMENT
B. UNSIGNED
C. NOT NULL
D. DEFAULT
Câu 8.3:Trường nào trong bảng "bannhac" được thiết lập làm khóa chính?
A. idNhacsi
B. tenBannhac
C. idBannhac
D. tenNhacsi
Câu 8.4: Khi khai báo khóa ngoài cho bảng "bannhac", trường nào được chọn làm khóa ngoài? A. idBannhac
B. tenBannhac
C. idNhacsi
D. idBanthuam
Câu 9.1: Khi khai báo khóa ngoài cho idNhacsi, bảng tham chiếu nào được chọn? A. bannhac
B. nhacsi
C. banthuam
D. casi
Câu 9.2: Khi khai báo khóa ngoài, kiểu dữ liệu của trường idNhacsi trong bảng "bannhac" nên là gì?
A. VARCHAR
B. TEXT
C. INT
D. FLOAT
Câu 9.3: Khi khai báo cặp trường (tenBannhac, idNhacsi) không được trùng lặp giá trị, loại khóa nào được sử dụng?
A. PRIMARY
B. UNIQUE
C. FOREIGN KEY
D. INDEX
Câu 9.4: Khi tạo bảng "bannhac", để thêm một trường mới vào bảng, bạn sử dụng thao tác nào?
A. Nhấn Ctrl+Alt+Del
B. Nhấn Ctrl+Insert
C. Nhấn Ctrl+Delete
D. Nhấn Alt+Insert
Câu 10.1: Giá trị mặc định của trường khóa ngoài idNhacsi trong bảng "bannhac" nên là gì?
A. NULL
B. AUTO_INCREMENT
C. 0
D. Một chuỗi rỗng
Câu 10.2: Khóa ngoài trong bảng "bannhac" tham chiếu đến khóa chính ở bảng nào? A. nhacsi
B. casi
C. banthuam
D. quận/huyện
Câu 10.3: Thao tác nào được sử dụng để khai báo khóa chính cho trường idBannhac?
A. Chọn "Create new index" → "UNIQUE"
B. Chọn "Create new index" → "PRIMARY"
C. Chọn "Create new index" → "FOREIGN KEY"
D. Chọn "Create new index" → "INDEX"
Câu 10.4: Sau khi khai báo xong các trường trong bảng "bannhac", thao tác cuối cùng là gì?
A. Chọn "Tạo bảng mới"
B. Chọn "Xóa bảng"
C. Chọn "Lưu"
D. Chọn "Chỉnh sửa khóa"
Câu 11.1: Chọn thao tác nào để thêm dữ liệu mới vào bảng trong HeidiSQL?
A. Nhấn phím Delete
B. Nhấn phím Insert
C. Nhấn phím Ctrl + S
D. Nhấn phím Alt + Enter
Câu 11.2: Khi chỉnh sửa dữ liệu trong bảng, để sửa nội dung của một ô dữ liệu, ta thực hiện thao tác nào?
A. Nhấn đôi chuột vào ô cần sửa
B. Chọn ô rồi nhấn phím Deletex
C. Chọn ô rồi nhấn phím Ctrl + Enter
D. Chọn ô rồi nhấn phím F
Câu 11.3: Trong HeidiSQL, tổ hợp phím nào được sử dụng để xóa các dòng dữ liệu đã chọn?
A. Ctrl + Delete
B. Shift + Delete
C. Alt + Delete
D. Ctrl + Shift
Câu 11.4: Để sắp xếp dữ liệu trong bảng theo thứ tự giảm dần của một trường (column), ta thực hiện thao tác nào?
A. Nhấp chuột phải vào tiêu đề cột và chọn "Sort Descending"
B. Nhấn đôi chuột vào tiêu đề cột
C. Nhấn chuột vào tiêu đề cột, sau đó chọn biểu tượng tam giácx
D. Nhấp chuột vào tiêu đề cột
Câu 12.1: Câu lệnh SQL nào dùng để lấy tất cả các trường trong bảng "nhacsi"?
A. SELECT * FROM nhacsi
B. SELECT idNhacsi, tenNhacsi FROM nhacsi
C. SELECT nhacsi.* FROM nhacsi
D. SELECT * FROM nhacsi WHERE idNhacsi > 0
Câu 12.1: Để tìm kiếm các bản ghi có tên nhạc sĩ bắt đầu bằng chữ "P", câu lệnh SQL nào là đúng?
A. SELECT * FROM nhacsi WHERE tenNhacsi = 'P%'
B. SELECT * FROM nhacsi WHERE tenNhacsi LIKE 'P%'x
C. SELECT * FROM nhacsi WHERE tenNhacsi LIKE '%P%'x
D. SELECT * FROM nhacsi WHERE tenNhacsi LIKE '%P'
Câu 12.2: Khi muốn xóa tất cả các bản ghi trong bảng "nhacsi", nhưng vẫn giữ cấu trúc bảng, ta sử dụng câu lệnh nào?
A. DELETE FROM nhacsi
B. DROP TABLE nhacsi
C. TRUNCATE TABLE nhacsi
D. DELETE * FROM nhacsi
Câu 12.3: Trong HeidiSQL, để lọc dữ liệu với tiêu chí "LIKE", ta chọn tùy chọn nào?
A. Edit > Filter > LIKE
B. Nhấp chuột phải vào cột dữ liệu, chọn Quick Filter và chọn LIKE
C. View > Data Filter > LIKE
D. Filter > Apply LIKE Condition
Câu 12.4: Để xem toàn bộ dữ liệu trong bảng "nhacsi" trong HeidiSQL, ta thực hiện thao tác nào?
A. Mở bảng "nhacsi" và chọn thẻ "Dữ liệu"
B. Chọn thẻ "Truy vấn", nhập câu truy vấn SQL
C. Chọn thẻ "Thiết kế bảng"
D. Mở bảng "nhacsi" và nhấn F5
PHẦN II. Câu trắc nghiệm đúng sai (4 điểm)
Câu 13.1: Lợi ích nào sau đây là lý do chính khiến việc quản trị cơ sở dữ liệu trên máy tính được ưa chuộng hơn so với quản lý thủ công?
a) Giảm thiểu tối đa sai sót trong quá trình lưu trữ và truy xuất dữ liệu.
b) Tăng cường khả năng tìm kiếm và xử lý dữ liệu nhanh chóng.
c) Dễ dàng sao chép và phân tán thông tin không cần kiểm soát.
d) Giảm chi phí bảo trì và đảm bảo an toàn dữ liệu tuyệt đối.
Câu 13.2: Tại sao MySQL thường được lựa chọn làm hệ quản trị cơ sở dữ liệu trong nhiều ứng dụng?
a) Vì MySQL là phần mềm mã nguồn mở và miễn phí.
b) Vì MySQL không hỗ trợ việc quản lý chặt chẽ sự nhất quán dữ liệu.
c) Vì MySQL thích hợp cho các bài toán quản trị cơ sở dữ liệu lớn và trực tuyến.
d) Vì MySQL yêu cầu phải có kết nối Internet để sử dụng.
Câu 13.3: Trong bảng banthuam, trường nào được chọn làm khóa chính? a) idBanthuam
b) idBannhac
c) idCasi
d) Không có trường nào
Câu 13.4: Nếu muốn quản lý thêm thông tin về ngày sinh của các ca sĩ, cơ sở dữ liệu cần thay đổi bảng nào? a) Bảng banthuam
b) Bảng bannhac
c) Bảng casi
d) Bảng nhacsi
Câu 14.1: Khi tạo cơ sở dữ liệu "mymusic" trong MySQL, bộ mã ký tự mặc định được chọn là gì?
a) ASCII
b) utf8mb3
c) utf8mb4
d) Latin1
Câu 14.2: Khi tạo bảng "nhacsi", để idNhacsi tự động tăng giá trị mỗi khi thêm bản ghi mới, tùy chọn nào cần được chọn? a) UNSIGNED
b) AUTO_INCREMENT
c) DEFAULT
d) UNIQUE
Câu 14.3: Trường "idBannhac" trong bảng "bannhac" có những đặc điểm nào sau đây?
a) Kiểu dữ liệu của trường "idBannhac" là INT và có giá trị tự động tăng.
b) Trường "idBannhac" cho phép giá trị NULL.
c) Trường "idBannhac" được đặt làm khóa chính và không cho phép giá trị trùng lặp.
d) Trường "idBannhac" có giá trị mặc định là một chuỗi rỗng.
Câu 14.4: Khi khai báo khóa ngoài cho trường "idNhacsi" trong bảng "bannhac", điều nào sau đây là đúng?
a) Trường "idNhacsi" tham chiếu đến trường "idNhacsi" của bảng "nhacsi".
b) Trường "idNhacsi" phải có cùng kiểu dữ liệu với trường tham chiếu trong bảng "nhacsi".
c) Khóa ngoài "idNhacsi" không yêu cầu phải khai báo khóa chính trong bảng "nhacsi".
d) Giá trị mặc định của trường "idNhacsi" có thể là 0.
Câu 15.1: Trong HeidiSQL, để thêm một hàng dữ liệu mới vào bảng nhacsi mà không cần nhập giá trị cho trường idNhacsi, bạn nên làm gì? a) Nhập giá trị thủ công cho trường idNhacsi.
b) Để trường idNhacsi trống và chỉ nhập giá trị cho trường tenNhacsi.
c) Sử dụng câu lệnh SQL để thêm dữ liệu và tự điền idNhacsi.
d) Nhấn phím Insert hoặc nhấp chuột phải để chèn hàng mới và chỉ nhập tên nhạc sĩ vào trường tenNhacsi.
Câu 15.2: Làm thế nào để xóa nhiều dòng dữ liệu trong bảng nhacsi trên HeidiSQL? a) Chọn dòng dữ liệu và nhấn phím Delete trên bàn phím.
b) Chọn nhiều dòng dữ liệu, sau đó nhấn tổ hợp phím Ctrl+Delete hoặc sử dụng biểu tượng xóa.
c) Sử dụng câu lệnh SQL DELETE để xóa các dòng dữ liệu.
d) Nhấp chuột phải vào từng dòng và chọn Xóa dòng.
Câu 15.3: Điều nào sau đây là đúng khi thêm mới dữ liệu vào bảng bannhac? a) Bạn có thể nhập bất kỳ giá trị nào vào trường idNhacsi.
b) Trường idBannhac tự động tăng giá trị khi nhập dữ liệu mới.
c) Bạn cần phải nhập thủ công tất cả các trường dữ liệu trong bảng.
d) Giá trị của trường idNhacsi phải chọn từ các giá trị có sẵn trong bảng nhacsi.
Câu 15.4: Điều gì sẽ xảy ra khi cố gắng xóa nhạc sĩ trong bảng nhacsi mà nhạc sĩ đó đã được tham chiếu trong bảng bannhac?
a) Dữ liệu sẽ được xóa hoàn toàn từ cả bảng nhacsi và bannhac.
b) Hệ quản trị cơ sở dữ liệu sẽ ngăn chặn việc xóa và thông báo lỗi.
c) Bảng nhacsi sẽ tự động cập nhật lại thông tin để không còn lỗi tham chiếu.
d) Dữ liệu trong bảng bannhac sẽ tự động xóa để phù hợp với thao tác trong bảng nhacsi. Câu 16.1: Câu truy vấn SQL nào sau đây sẽ lấy danh sách tất cả các bản nhạc cùng với tên nhạc sĩ sáng tác từ hai bảng bannhac và nhacsi?
a) SELECT bannhac.tenBannhac, nhacsi.tenNhacsi FROM bannhac JOIN nhacsi ON bannhac.idNhacsi = nhacsi.idNhacsi;
b) SELECT bannhac.tenBannhac, nhacsi.tenNhacsi FROM bannhac LEFT JOIN nhacsi ON bannhac.idNhacsi = nhacsi.idNhacsi;
c) SELECT 	bannhac.tenBannhac 	FROM 	bannhac 	WHERE 	nhacsi.idNhacsi 	= bannhac.idNhacsi;
d) SELECT bannhac.tenBannhac, nhacsi.tenNhacsi FROM bannhac, nhacsi WHERE bannhac.idNhacsi = nhacsi.idNhacsi;
Câu 16.2: Câu truy vấn SQL nào sau đây lấy danh sách các bản thu âm với đủ thông tin về tên bản nhạc, tên ca sĩ và tên thể loại, từ ba bảng banthuam, bannhac, và casi?
a) SELECT banthuam.idBanthuam, bannhac.tenBannhac, casi.tenCasi FROM banthuam JOIN bannhac ON banthuam.idBannhac = bannhac.idBannhac JOIN casi ON banthuam.idCasi = casi.idCasi;
b) SELECT banthuam.idBanthuam, bannhac.tenBannhac, casi.tenCasi FROM banthuam LEFT JOIN bannhac ON banthuam.idBannhac = bannhac.idBannhac LEFT JOIN casi ON banthuam.idCasi = casi.idCasi;
c) SELECT banthuam.idBanthuam, bannhac.tenBannhac FROM banthuam WHERE banthuam.idCasi = casi.idCasi;
d) SELECT banthuam.idBanthuam, bannhac.tenBannhac, casi.tenCasi FROM banthuam, bannhac, casi WHERE banthuam.idCasi = casi.idCasi;
Câu 16.3: Nhiệm vụ nào dưới đây thuộc về nhà quản trị cơ sở dữ liệu (CSDL)? a) Thiết kế và lập trình ứng dụng phần mềm.
b) Cài đặt và cập nhật các hệ quản trị cơ sở dữ liệu (QTCSDL).
c) Phát triển hệ thống mạng trong tổ chức.
d) Quản lý tài liệu giấy tờ liên quan đến CSDL.
Câu 16.4: Nhà quản trị CSDL cần có những phẩm chất nào sau đây? a) Kiên nhẫn, tỉ mỉ và có khả năng phân tích.
b) Kỹ năng giao tiếp xã hội tốt để thương thảo hợp đồng.
c) Kiến thức chuyên sâu về thiết kế đồ họa.
d) Khả năng sử dụng ngôn ngữ truy vấn SQL thành thạo.

III. PHẦN TỰ LUẬN (1.0 đ)

-	Cho các thuộc tính của một đối tượng cần quản lý và xác định khóa chính (Bài 13, câu 1, 2 và phần Luyện tập trang 68)
-	Phần mềm HeidiSQL nắm các bước tạo lập bảng, chỉ định khóa chính cho bảng (bài 19)

[bookmark: _GoBack]IV. PHẦN THỰC HÀNH (2.0 đ) (GV chủ động thời gian cho HS kiểm tra trên máy tính)       Vận dụng các phần đã học trong bài 17, 18, 19 để lập CSDL trong mục vận dụng ở sách giáo khoa trang 94.
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